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1. Introduction 
Publishing Statistical Data for ASEAN is the task and the obligation of the Statistical Unit of the 
ASEAN Secretariat (often referred to as ASEC). ASEANStats will be used as abbreviation of this unit.  
ASEANStats has published mainly 4 regular publications usually in a yearly rhythm: (ASEAN Statistic 
Yearbook”, the “ASEAN Community in Figures” (ACIF), the “ASEAN Economic Community 
Chartbook” and the “ASEAN Statistic Leaflet). These publications exist on paper, and are on display 
at the ASEC At intervals the information has been displayed as PDF documents on the statistical 
publication website of ASEC (http://www.asean.org/resources/2012-02-10-08-47-55/statistical-
publications)  . The current project envisages a yearly production of this essential statistical 
information via an automated data base backed system called henceforth the ASEANStats Report 
Writer (ARW).  

This project is envisaged not only to produce regular documents of the likeness of the 4 above 
mentioned products but also open the door for a regular door opener to the comprehensive and 
well stocked information at ASEC and ASEANStats. A positive example of this potential and in future 
open portal to fact based information can be viewed at the “Statistics Explained, your guide to 
European statistics” (http://epp.eurostat.ec.europa.eu/statistics_explained/index.php/Main_Page). 
“Statistics Explained is an official EUROSTAT website presenting all statistical topics in an easily 
understandable way. Together, the articles make up everyone's encyclopaedia of European 
statistics, completed by a statistical glossary clarifying all terms used and by numerous links to 
further information and the very latest data and metadata, a portal for occasional and regular users 
alike.” This is by no way the scope of the current project, but a vision of a professional and accessible 
web based information system for ASEAN has been and must be on the agenda.   

This document will describe the scope and the use of the ARW in a first draft. This will be a living 
document and should flow into a similar information platform as above. The data based ASEANStats 
Report Writer (ARW) is a precondition for any further pursuit of ASEAN and its statistical service to 
contribute to its vision: Making ASEAN become a community in 2015. 

2. Data Transfer 
Data for the different print products of ASEANStats have been available from various sources, 
constituting one of the major problems at ASEANStats to produce repeatable annual documents of a 
reliable quality.  The user interface is called: (http://kamoro.com/aseanstats/Default.aspx), the 
Google Chrome Browser is for the time being mandatory. 

The first task is transfer the data to the data base (SQL server 2008 as is for the moment) to be later 
published by the ARW. For this all the data used for the different ASEANStats publication have to be 
transferred to EXCEL templates. How 
this is done will be explained in due 
course of this document.  

The data transfer screen opens like this, 
for the moment the application runs on 
a desktop server with limited memory capacity and will be replaced by a production server for the 
start of the production phase: 

Figure 1 
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For a brief and basic understanding: The Relational SQL database stores the data in Tables of 
Indicators, which own (up to ten) attributes. In the data base attributes 
at a descending hierarchical level are called attribute members. Data 
are finally stored with these Attributes. Together with tables of 
physical units (countries, country groups etc.) and of temporal units 
(year, quarter etc.) this is the structure of the ARW data.  

For the data transfer three main menu options are available: 

Data Input: For data transfer from templates to the SQL data base 
(upload) and for update (maintenance) of existing data. Also download 
of indicators and values is possible via this menu entry. The data structure is a newly-created unified 
and generic data structure (hereafter called “INDICATOR”) governed by several properties (hereafter 
called “ATTRIBUTES”) which in turn when being combined with COUNTRY and YEAR are able to 
identify specific data tables and values.  

Bulk Delete: As the data transfer is a batch process, deletion and new 
transfer of data is preferable to update in certain cases. Bulk delete 
allows for clearing existing data files and allows re-transferring them 
again.  Deletion is possible for Indicators and Attributes. Groups are 
meant to unify data series under one group name, the group mapping 
refers to the attribution of data series to a group name. This generic 
explanation will be made clearer in further detailed examples.  

Administration:  The Administration menu allows modifying existing 
structural elements of the data, except Indicators and Attributes which 
are administered in the “Data Input”. Here also new value of the menu 
elements can be added (e.g. a new country). This is true for all the other 
menu items under “Administration”. In Foreign Trade the Harmonised 
System (HS) Codes are used to identify commodities. The Harmonized 
Commodity Description and Coding System, also known as the 
Harmonized System (HS), of tariff nomenclature is an internationally 
standardized system of names and numbers for classifying traded 
products developed and maintained by the World Customs Organization 
(WCO). The system begins by assigning goods to categories and from 
there proceeds to categories with increasing complexity employing a 
hierarchical coding system (meaning the same initial digits indicate a 
coherent group of products). The HS therefore sets forth all the 
international nomenclature from the 6-digit level through 8 digits at the 
tariff-rate line (legal) level until a total of 10 digits. The products are 
grouped for publication according to the first 2 , 4 or 6 digits. These 
groups are referred to as the HS Master in the menu for 
“Administration”. The data storage allows for another classifier “Version” which is populated so far 
with “HS96” meaning the 1996 version of the HS. The HS code mapping to the mentioned groups is 
done through “HS Mapping”. The menu entry “Books” refers to the different publications to be 
printed by ASEANStats (the above mentioned 4 and maybe others to come). 

 

Figure 2 

 

Figure 3 

 

Figure 4 
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2.1. Data Input 

First Menu Item: “Upload Indicator Value”: 

The “Upload Indicator Value” controls are typical for the general use of the forms: 

1. The Indicator selection follows a common pattern of selecting items: 
Press “1.” and type the first characters of a required selection: 
Select the required item (here Indicator) by clicking on the table line and proceed 

2. Downloads the associated template with containing data or 
3. Downloads the associated template 

Figure 7 shows an example downloading the FDI template together with the containing data 
The downloaded EXCEL file can be viewed, stored etc..  

4. Works just in reverse, selecting a file from the file system and  
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1 

2 3 

4 

5 

 

Figure 6 

 

Figure 7 
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5. Upload it to the data base (see also next chapter 2.2. Bulk Delete for precautions  concerning 
updates) 

Second Menu Item: “Upload Attribute Member”: 

1. The Indicator selection is followed by choosing 5 the attribute name (here FDI and 
Investors county code): 

Press “1.” and type the first characters of a required selection: 
5. Select the required item (here Attribute Name) and proceed 
2. Downloads the associated template with containing data or 
3. Downloads the associated template 
4. Works just in reverse, selecting a file from the file system and  
6. Upload it to the data base (see also next chapter 2.2. Bulk Delete for precautions  

concerning updates 

Third Menu Item: “Maintain Indicator Value”: 

1. The Indicator selection (here FDI )- all the following attributes are specific for FDI and 
will change for another indicator  

Press “1.” and type the first characters of a required selection: 
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2. Select the required country  (here “Indonesia”) and proceed 
3. Select the starting year   
4. Select the end year   
5. Select the investing country by its country code (here “AU” for Australia). 
6. Choose the search button, to 
7. Display the available data items, which can be  
8. Exported to EXCEL 

In order to add and indicator value, press  
9. Add Indicator Value 

 

Fourth Menu Item: “Add Indicator Value”: 

1. The Indicator selection (here FDI )- all the following attributes are specific for FDI and 
will change for another indicator  

Press “1.” and type the first characters of a required selection: 
2. Select the required country  (here “Indonesia”) and proceed 
3. Select the year   
4. Select the investing country by its country code (here “AU” for Australia). 
5. Choose the attributes and values , then 
6. Save or Cancel (After Save the new values are displayed as in Figure 9/7) 

You can also delete the Indicator value clicking on it in the EXCEL style list and choosing 
“delete” or pressing the button “delete”   which appear right of the Indicator value after you 
have saved the Indicator value 

7. You can “Add” another Indicator Value. Clicking will make another line of  Indicator 
Values appear. “Delete” removes this value from the entry screen. “Save “ stores it in 
the data base. 
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2.2. Bulk Delete 
Deleting Attributes and their Values can be done via the “Data Input” menu but also using “Bulk 
Delete”.  

The selection of Attributes and their Values is known from the previous examples: 

First Menu Item: “Delete Indicator Value” 

1. The Indicator selection (here FDI )- all the following attributes are specific for FDI and 
will change for another indicator  

2. Select the required country  (here “Indonesia - ID”) and proceed 
3. Select the year (here “2008”) 
4. Select the time type/ period  (here “year”)  
5. Select investor country  (here “Australia - AU”) 
6. After clicking “Search” the EXCEL style Indicator Value is displayed 
7. Pressing “Bulk Delete” will delete it from the data base 

. 
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Second Menu Item: “Delete Indicator Attribute Member” 

 

1. The Indicator selection (here FDI )- all the following attributes are specific for FDI and 
will change for another indicator  

2. Select the required Attribute Name  (here “Investor Country Code”) and proceed 
3. After clicking “Search”  
4. The EXCEL style Indicator Attribute Names are displayed 
5. “Bulk Delete” will delete all of the Indicator Attributes from the data base 

 
“Bulk Delete” is also possible from the “Administration” menu for various items, which 
will be discussed in the next chapter 

  

 

 

Figure 12 

1 

2 

3 5 

4 

http://www.kamoro.com
http://www.klaus-roeder.com


 
 

                                                                         
Handbook ASEANStats Report WriterµKAMORO http://www.kamoro.com µ Klaus Röder http://www.klaus-roeder.com 

04/12/2013  Version 0.6  Page11 
 

2.3. Administration 

First Menu Item: “Country Administration” 

1. The country  selection  
2. After clicking “Search”  
3. the EXCEL style country list is displayed 

Select the required country (here “Indonesia - ID”) and proceed 

 
Short and Long Name can be edited and can be Updated or country can be deleted. 
Another option is to flag the country as inactive to exclude it from further processing. 
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Second Menu Item: “Country Group Administration” 
This works just like the previous example 

1. The country  group selection  
2. After clicking “Search”  
3. the EXCEL style country group list is displayed 

Select the required country group (here “ASEAN”) and proceed 

 
Short and Long Name can be edited and can be Updated or country can be deleted. 
Another option is to flag the country as inactive to exclude it from further processing. 
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Third Menu Item: “Country Group Mapping Administration” 
1. The country  group selection  

2. You can limit the search by indicating a country code or a combination of letters. If the 
field is left empty all countries mapped to that country group are displayed  

3. After clicking “Search”  
4. the EXCEL style list containing a country group with its mapped countries  is displayed 

Select the required country (here “Indonesia - ID”) and proceed 

 
Names can be edited and mapping can be updated or mapping to the country group can 
be deleted. From the main menu 
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5. Add Country group mapping  will allow to add an existing country (by code) to the 
selected group  

6.  
A
n
o
t
h
e
r
 
o
p
t
i
”
A
d
”
”Add” in this form opens another line, “Save” will save the mapping in the data base.   

Fourth Menu Item: “Time Type Administration” 
1. The time type  selection  

2. After clicking “Search”  
3. the EXCEL style time type list is displayed 

Time types can be edited and mapping and can be deleted.  
From the main menu: 

4. “Add Time Type” will allow to add a new Time Type if required.   
 

 

 

Figure 17 
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Fifth Menu Item: “Indicator Administration” 
1. The Indicator  selection  

2. After clicking “Search”  
3. the EXCEL style time type list is displayed (selection limits with characters as usual) 

Indicators can be edited and can be deleted.  
From the main menu: 

4. “Add Indicator” will allow to add a new Time Type if required.   
Clicking on one of the Indicators will open the “Update Indicator” screen 
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Sixth Menu Item: “Indicator Attribute Member Administration” 
1. The Indicator  selection  

2. Attribute Name can be preselected with character selection of field will be kept blank 
(selection limits with characters as usual) 

3. After clicking “Search”  
4. the EXCEL style Attribute Member list is displayed  

Indicators can be edited and can be deleted.  
From the main menu: 

5. “Add Indicator Attribute Member Administration” will allow to add a new Indicator 
Attribute Member if required. This  new Indicator Attribute Member is placed at the 
next lower (descending) hierarchical level. “Add”, “Save” and “Cancel” works as in 
above examples. 
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Seventh Menu Item: “HS Master Administration” 
1. The Version  selection (e.g.HS96) 

2. HS Name can be preselected with character selection of field will be kept blank 
(selection limits with characters as usual) 

3. After clicking “Search”  
4. the EXCEL style list of HS Codes is displayed  

Indicators cannot be edited but can be deleted (only “Bulk Delete”) is possible so far.  

Eighth Menu Item: “HS Mapping Administration” 
This is to map the HS Codes (of more than 2 digits) to HS Group Codes (of 2, 4 or 6 
digits). The screen is there but functionality remains to be implemented.  
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Ninth Menu Item: “Books Administration” 
Books represent the different statistical documents produced by ASEANStats.  

“Add Book” will allow to add a new Books if required. Edit of existing Entries by Click on 
list.  “Update”, “Delete” and “Cancel” works as in above examples. 
 

Tenth Menu Item: “Book Content Administration” 
This now is an essential part of the ARW product, linking the different elements of the 
publication (Tables, Graphs or Abstract (not yet implemented) ) to the appropriate Book. 
Clicking on the EXCEL style list of elements allows to Modify, the “Update” or “Delete” 
these elements as seen above. 

  

 

Figure 27 
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Eleventh Menu Item: “Generic Group Master Administration” 
This refers to sections or chapters of the publication products, linking the different 
elements of the publication (Tables, Graphs or Abstract (not yet implemented) ) to the 
appropriate Book Sections. Clicking on the EXCEL style list of elements allows to Modify, 
the “Update” or “Delete” these elements as seen above. 

  

 

Figure 29 
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Twelfth Menu Item: “The Roles” 
This refers to the right administration of users of the products.(not yet fully 
implemented) ). Clicking on the EXCEL style list of elements allows to Modify, the 
“Update” or “Delete” these elements as seen above. 
 

 

  

 

Figure 31 
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3. Design of Documents 
 

3.1 Using Xml as External Data Source on Excel  
 

Before following the steps below, please download the excel file that can be found on the following 
link :http://asip.asean.org/upfile/images/CH1_population_12_v1_rev_from_Ica_draft.xlsx 

The download screen looks as follows (download the XLS-Year Book Table 1): 

For this example, we will use table I.3 that can be found on tab Pop.I.3: 

 

 

3.1.1 Adding the Developer tab on the excel ribbon.  
By default, the Developer tab is not displayed on the excel ribbon. To add the Developer tab, 
please follow these steps :  

a) On the File tab, click Options  
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b) Click Customize Ribbon, then check the Developer checkbox 

 
 

 

3.1.2 Mapping the xml file to the excel file. 
Now that the Developer tab has been added, the next step is to map the xml to the excel file. 
Please follow these steps : 

a) On the Developer tab, click Source  
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b) After the XML Source window is shown, click the XML Maps button  

 
 

c) XML Maps dialog box will appear, click Add button 

 
 
For this example, we will use the [table I.3.xml] that has been uploaded to the server. 
Please copy the following link to choose the xml file. 
http://asip.asean.org/upfile/images/table_I.3.xml 
 

http://www.kamoro.com
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After clicking Open button, the XML Maps dialog box will have a new xml map listed on 
the grid. By default, the xml map will be named root_Map. To better understand which 
layout will be using the xml map, we can rename the xml map’s name by clicking the 
Rename button. In this example, the xml map’s name will be renamed to table_I.3 

 
 
After renaming the xml map, click the OK button. 
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d) The XML Source window will show the values contained in the table_I.3 xml map that we 
are going to map in this example.  

 
 

 

3.1.3 Mapping the values from the xml to the excel cells. 
Before mapping the values, clear the existing data in the excel template. 

a) Existing data in the template. 
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b) Clearing the existing data. 

 
 
 

After the existing data has been cleared, please follow these steps to map the values from the 
xml to the excel cells. 

a) Map the table title 

 
The cells mapping can be done by dragging the xml value to the destination cell or by 
selecting the cell first and double-click the xml value.  
Removing the mapping can be done from the XML Source window by doing the 
following : 

http://www.kamoro.com
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i. Right-click the xml value, click Remove Element 

 
 
 

b) Map the column headers 
i. Map the values year_1 to year_9 that can be found on header in the XML Source 

Window to cell C4 to N4.  
ii. Map rank_year to cell O3. 

 
 
c) Map the values in row 

i. Map country to cell A6 

http://www.kamoro.com
http://www.klaus-roeder.com


 
 

                                                                         
Handbook ASEANStats Report WriterµKAMORO http://www.kamoro.com µ Klaus Röder http://www.klaus-roeder.com 

04/12/2013  Version 0.6  Page28 
 

 
 
As can be seen in the picture above, unlike the mapping in the previous steps, a 
table is created for country. This is because country contains more than 1 data, 
it contains a list of countries ( Indonesia, Singapore, etc ), while the mappings 
done in the previous steps all contain 1 data. Whenever we map a value that 
contains more than 1 data, a table will be created. 

ii. Clear the table styles. Move the cursor the table created for country, click the 
Design tab, then uncheck Header Row to remove the column header on the 
country table, and uncheck Banded Row.  

 
 After removing the header row, open the table styles list  

 
After the table styles list is shown, choose the Clear option. 
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Right-click cell A7, Format Cells, and remove the border of the cell. This is to prevent the 
table created for country from making new borders on the existing layout. 

 
 

iii. After removing the Header Row , cut the cell A7 (which has already been mapped 
with country) and paste it to cell A6 , so that the countries will be populated 
starting from cell A6.  

iv. Map the rest of the values in row to the appropriate cells. If the rest of the values 
are mapped directly next to a table (e.g. cell B6 is right next to A6), then you will 
not have to repeat step (ii.) and (iii.), because cell B6 will be treated as one of 
the columns of the table created for cell A6, so a new table will not be created. 
 

http://www.kamoro.com
http://www.klaus-roeder.com


 
 

                                                                         
Handbook ASEANStats Report WriterµKAMORO http://www.kamoro.com µ Klaus Röder http://www.klaus-roeder.com 

04/12/2013  Version 0.6  Page30 
 

When mapping the rest of the values, you might encounter this warning dialog 
box. 

 

This warning shows up because the existing formatting of the cell is different 
from the data type of the value. In this example, cell B6 is of number type, while 
all of the values provided on the xml are of text type (we do the number 
formatting in the database). If you encounter this warning dialog, please click 
Match element data type button. 

 

 
d) Map the footnote to cell A18. 

 
 

3.1.4 Refreshing the data 
After the mapping has been done, please follow these steps : 

a) On Developer tab, click Map Properties. Uncheck Adjust column width to avoid the 
mapped cells’ width from being adjusted whenever we refresh the data 
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b) On Developer tab, click Refresh Data 
 

 
 
Result :  
 

 
 
As shown on the picture, some previous formattings like center alignment on the 
population density cells, and bold text on cell A16 are no longer applied. After the values 
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from the xml are refreshed for the first time, we may need to re-apply the formattings. 
But the next time we refresh the data, the formattings should not be lost. 

 
 
 

3.1.5 Re-select data for the chart. 
In this example, the chart is selecting the data from E-16 to K-16. Because the values provided 
from the xml are of text type, the graph will look like below. 

  
 

To re-select the data for the chart, please follow these steps :  

a) Choose a range of cells outside the print area, for example M20 to S20 
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b) Put the cursor to cell M20, and type the formula =NUMBERVALUE(E16). N20 to S20 
should also have this formula targeted to the appropriate cells. 

c) Right-click the chart, and click Select Data 

 
 
For each legend, edit the series values to point the new cells that contain the 
=NUMBERVALUE() formula  
 

 
 
Legend 2005 currently points to cell E16 
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Edit the series values so that it will point to cell M20 

 
 
Repeat the steps above until all the legends point to the new cells. 
 
The result should now look like the picture below : 

 
 
 

3.1.6 Editing the values in the xml.  
Download the xml to your local computer by opening this link on your browser : 
http://asip.asean.org/upfile/images/table_I.3.xml. (download the XML-Year Book Table 1). After 
the link is opened, right-click on the page, click save as, and save the xml file to your local 
computer. 
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Now that the xml is on your local computer, you can edit the xml file using various text editor 
programs like notepad, notepad++, wordpad, etc. The text editor shown in the picture below is 
notepad++.  

 
 
Please follow these steps : 

a) Edit the table title value to “USING XML AS DATA SOURCE DEMO- Table I.3 : 
Population Density, 1980-2011”, and save the xml file. 
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b) Back to the excel program, click Refresh Data on the Developer tab. 

 
 

c) You will notice that the table title does not change to “USING XML AS DATA SOURCE 
DEMO- Table I.3 : Population Density, 1980-2011”. It is because the excel file is still 
using the xml file on the server (http://asip.asean.org/upfile/images/table_I.3.xml) as 
the data source.  

d) To have the excel use your local xml file as the data source, on Developer tab, click 
Import 

 
 
Choose the xml file on your local computer 
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Result : 
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4. Making Stats Data visible 
This chapter should describe the further use of the ARW for presenting the resources, data 
and analytical expertise of ASEANStats. This should describe technical details of a vision of an 
ASEANStats information platform. The objective should be to attract users and observers to 
this information platform and present a comprehensive image of ASEAN in numbers based 
on reliable statistical analysis.  
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5. Training for the ASEAN Report Writer  
 

Module 1: Introduction to the ASEAN Report Writer:  
Unit1: What is the ASEAN Report Writer and what is it for? 

Unit2: The different sections of the ASEAN Report Writer 

Unit3: Outlook  for the future / How do we want ASEANStats to present information  

 

Module 2: The Data Transfer  
Unit1: Explaining  the  Transfer  Screens 

Unit2: The structure of data in the ASEANStats ARW (Indicator, Attributes, Data, Physical Units – 
countries etc., Temporal Units – Years etc.) 

Unit3: Data Input, Bulk Delete and Administration  

Exercises Module 2:  

Use Prepared data set  

Transfer / Modify / Delete Indicators, Attributes and Data 

Bulk Delete / Delete in “Data Input” Menu 

Using the “Administration Menu”  

Using the “Extraction” Menu for the creation of XML files 

 

Module 3: The Page Design  
 Unit1: Explaining  the Extract Files  

Unit2: The structure of tables for design of ASEANStats publications 

Header, Rows, Titles etc.  

Unit3: Special issues of tables for design of ASEANStats publications  

 Functions, Footnotes etc. 

Exercises Module 3:  

Use Prepared data sets  

Fill Tables and use Elements of Tables 

Use Graphs created by Tables 

Using Special issues of tables   

Final preparation of Abstracts, Tables and Graphs for the Print Shop 
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